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[ASP.NET MVC3 >" ]1. MVC(Model - View R Controller)
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- Model : MVCy @k foed we o { a1 HB. Y/ F1e k
Dat abase Table g row w®WQ. t#bOoH L OF O nr At
t si+HWAO. o EE T NI T+ EHigEn o0 e
é+Y> _ \nimageTypey T r0% -1, xml streaml XDocument
i. DAL(Data-AccessL ayer) , BLL(Business Logi c Layer
- View : MVC/ A Viewlk OQoc/ 7~ 3% HiA O0+95 Ul C wmdbol
/A v 1 -~ " F FHin £¢ MVCTQr T/ K § 1 Fa~ P
o.(v> DateTime L u/n/®™ Agr «t, DateTimePicker
n YE "x%0)' @O " Viewk wf 1 045K 1/, T HAT K b
Q.
- Controller MVC/ AqrController L BLL(Business Logic
View /A wf n O045Model L o -, /7 §gm 3x¢ HAL "5
c 1T 0. ,f§Oef7i ke s/ bST HO.

MvC" M4 "E0/ t¢CL 3, Q0cs ek F ASPNET ASPNETMVCK t€ 1 L ¢ -
KR v+ € 40. Py ¢nRtn Qd MVC o |V, " O« ./ §aAASP.NETOO

X u £ Yu'EL 14 H™ ©.v s ASP.NET Classicl #$ & K

W' A ,MVC" . F ASP.NETL nn o By "n <"

1.UrlRouting = €4 47T RLYF Owe 4 URLL o oF

2.0Query p Jv., ¥, e A " WMp(F 4 Obeqrm & sSl,e, " oF
3.104 £0y ., F ASP.NETOO v ., &L v "o
4. ViewState" ', v/ [ FR" "no.
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[ASP.NET MVC3 >~ ]2. MVC "E

a

MVCh Q. ., — A, paq71 "~ C 35+0 Visual Studio2008 £+ U O, + % o©.
MS/ 'AIE WPI(Web Platform Installena €1 L ¢ Of~ yo.WPIlE [ [ e/ % ©° 6 %i "
EA T Nt T, e [t T EH REA o TA e 4e/ e L

E vud 0. k€ 4o,

1. ¢ Visual Studio 2010 L 8 A 0.0 =71 il l€ £ (http://www.microsoft.com/visualstudio/ko -

kidownload )/ A" & ©o. " Q/ T MSKE“1°/ A" Aaq1 Liet 0. i
HT (DreamSparkY )L £~ y ' 10 Oki1in*Lli1-o.

2.y wdTt <« Qui WebPlatforminstaller 1 €A o." o a0l

=|=° (http://www.microsoft.com/web/downloads/platform.aspx Y A Y ®P

3.4t EAN 2 0.
© Web Platform Installer 3.0 l l ‘ ‘ i o0
Spotlight Products Applications pe]
Name Released Install =
A :': Microsoft WebMatrix 2011-05-17 Installed
| Applications
! __| Products 1? DotMNetMuke® Community Edition 2011-05-06
Lj EC-CUBE 2011-04-27
WY Wordpress 2011-04-27 Add
K Joomlal 1.6 2011-04-21 1
e’ Application Request Routing 2.5 2011-03-29
oomus:  Visual Web Developer Express 2010 5P1 2011-03-10
ot wso  Visual Studio 2010 5P1 2011-03-10 Installed
f.:."';f,'i Drupal 7 Developer release 2011-01-19 .
hl‘ R o ol N - R N [ Y 5 S S ANAA 44 A0 A kT4
0 Iltems te be installed Options Install Exit
(= - -

[ B :Web Platform Installer]
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http://www.microsoft.com/visualstudio/ko-kr/download
http://www.microsoft.com/visualstudio/ko-kr/download
http://www.microsoft.com/web/downloads/platform.aspx

CO ~ Product L ¢ Mvc3 L ¢ yo.
© Web Platform Installer 2.0 ‘ =] . S
Spotlight Products Applications pel
Tame Feleased Tnsta |
] AR . . =
ASP.MET MVC 3 (includes April 2011 Tools Update) 2011-04-11 Remove 3
Server
.+ Frameworks Visual Web Developer Express 2010 5P1 2011-03-10 Add
Database
f‘; l Tools SQL Server Express 2008 R2 2010-05-18
Microsoft® SQL Server® Compact 4.0 2010-10-15 Installed
« 057 Recormmended Configuration 2010-11-10
:: 1 057.5 Express 2011-04-12 Installed
ﬁih Web Deployment Tool 2.1 2011-04-11 Installed
ns Microsoft NET Framework 4 2010-04-12 Installed
Web Farm Framewerk 2.0 2011-01-20
|
h‘.‘h [N Ua T DT N, AnAn AT N A kT4
2 [ltemsto be installed Options ’ Install ] ’ Exit ]
[ -
¢ t3 ,MVCn §A . — *TEL"niet el asSEAn no.

‘Web Platform Installation
-

LX)

Review the following list of third party application software, Microsoft preducts and components to be installed and
Windows components to be turned on. Third party applications and products are provided by the third parties listed
here; Microsoft grants you no rights for third party software. You are responsible fer and must separately locate, read

and accept these third party license terms,

7% ASP.NET MVC 3 (includes April 2011 Tools Update)

ASP.NET MVC 3 Tools Update Installer (Dependency}

View license terms

Privacy Terms
Downloaded from:

http -//download microsoft com/download.F/3/1,/F31EF055-3C46-4F 35-ARTHR-3261

AID3AIBE/ AspMetMVC 3 Toolspdate Setup exe

ul O e aC|
ASP.NET MVC 3 Tools U Language Packs

ASP.NET MVC 3 Tools Update Language Packs Installer (Dependency)

Privacy Terms
Total file download size:

L3

20.39 MB

20.39 MB

By clicking "I Accept,” you agree to the license terms for the third party and Microsoft software listed above. If you do

not agree to all of the license terms, click "I Decline.”

I Decline l [

I Accept ]

[

B
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DT w ot T EAN" 4B go.

Web Platform Installation
———

We're installing your products. Please wait.

Finished downloading

I!

Meed to find a hosting provider for
your website?

The online Web Hosting Gallery can
help you find the right one, with the
right technologies at the right price.

www.microsoft.com/fweb/hosting

Install progress: Installing ASP.MET MV 3 Toels Update Installer [1 out of 4]

‘Web Platform Installation
- -

ASP.NET MVC 3 Tools Update Installer

ASP.MET MVC 2 (includes April 2011 Teols Update)
ASP.NET MVC 3 Tools Update Language Packs Installer
ASP.MNET MVC 3 Tools Update Language Packs

v Congratulations! You have successfully installed the following products:

[ B MVC3' 2 £ £ AN]




Web Platform Installation
-

ASP.MNET MYC 3 Tools Update Installer

ASP.MET MYC 3 (includes April 2011 Tools Update)
ASP.MET MVYC 3 Tools Update Language Packs Installer
ASP.MET MVYC 3 Tools Update Language Packs

v Congratulations! You have successfully installed the following products:

[ B :MVC3EA §8]
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[ASP.NET MVC3 >~ ] 3. HelloWorld MVC

New Project — M

[.NEF Framework 4 - ] Sort by: [DEfEuH: Y] | Search Installed Templates R |

Installed Templates . )
—_ Type: Visual C#

. E‘cﬁ Windows Forms Application Visual C#
< EEraley = A project for creating an application using

Windows =i ASP.NET MVC 3
Web | WPF Application Visual C#

Office

Cloud |=ch Console Application Visual C#

Reporting

SharePoint Y ASP.NET Web Application Visual C#

Silverlight

Test

WCF

Workflow
Other Languages
Other Project Types
Database ¥

Class Library Visual C#

ASP.NET MVC 3 Web Application Visual C#

Ui:uﬂ -3

Modeling Projects
Test Projects

&

¥
Online Templates Cgﬁ WCF Service Application Visual C#

cip,

>

ASP.NET Dynamic Data Entities Web Appli... Visual C#

Silverlight Class Library Visual C#

Name: HelloWorldpp

Location: chusershloveciel\documents\visual studio 20104 Projects -

Solution name: HelloWorldpp Create directory for solution
|| Add to source control

WPIn £+, AMVCEAND sUaqT 2 Hoa —F% £ mve3 L e
1x H"o.4, A, pedt =i FHL MVCtr bled wo A u  o.

b e Project > WebApplication>MvC3 L &8 A A" | Empty Projectn £ 0.

MVC Tt K H$+ o "hFA ~"" € Model * , 1L ee € Controler,,6 =~
ey ' >L O451€ ViewT FH1in .1t pa bk MvCE s $H 5/ 1€
Model + § T F =~ RN QIo.
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m Solution 'HelloworldApp3' (1 project)
4 28 HelloworldApp3
[ [=d| Properties
[+3] References
[ Content
[ Controllers
[d Models
[ Scripts
Ea Views|
ﬁ] Global.asax
% packages.config
[> @Web.config

VW

1. Routing

MVCIE , 4143717 SEO/A &4 URLF Routing L p° ~ 41
+ X% 0.

O.f A ARouting/ b

®J & Routing k Globalasax’ s1" Hi

routes. IgnoreRoute( “{ resource}.axd/{+pathinfo} ")

rout es. MapRoute(
"Default”, // Route name
“{control ler}/{action}/{ id}", // URL with parameters
new { controller = "Home", action = "Index", id = UrlParameter.Optional

S
-~

Routing £ —F% -~ B Aq71 #Hih
= 1$ L I Routing A%
HAL ¥ 3 4o.

routes.MapRoute("2t5% 0|18~, 2tFE 5", “7I12%")

fine. .+ /ARE Fe - UEARIEE |
L =, 1€ routes.MapRoute() § Ait " F o A=fF L KA

- Routing/ A sqy 1 E [ Fnf L controller [ /acton | /noidT s At a2
+ 8 . p>F ApHT QO a1 At F£ Qo .t p>/ §
=i=ﬂn .iﬁ w

O.N, Ay At / AlE controller >4 home g T action > index

AT HTQ http//, p & /0 . L = http//. p & [homelindex T =|=e oK1
O+170.#21t EvVadtHAqT sy He,—/ Aagy at ' E/A=naqy At
At =/ AATH AT T €Cmm YO - O,

Q/ globalasax/ A" T L T EMVCly A"y, mE O]

}

0.

m

-
1L

+

10


http://기본호스트/
http://기본호스트/

2. Controller

Routing / § ! 3 ~ http://localhost 0 A T~ Ha Home & =1/ index Action L

A Tu £ aHt 1l Q o - MVC Tt / e & =/ ke
11y agH1 +nn A . — HomeController n
YE F ¢ 3 . F asp.net’ C= controller

lEnw $1 E aspnetMVC/ A ¢ OFIE G~ bBiFa”
e . xq17Q , ceqT Y'E Y |, W+o. F Contoller n ¢ °

homeController » Y"E Tiu 0.

[ L gL =L === L [ LS AL UL DELLNYS T g e =

Solution Explorer
Q=2 El e
=5 _; Selution 'HellowerldApp3' (1 project)
o .L:Ja HelloworldApp3
> |=d| Properties
» =3 References
H » 1 Content

3 _Cantrollers
Convert to Web Application ;els

@ Check Accessibility... ts
Add U I:=-| Controller... Ctrl+M, Ctrl+C
rel Exclude Fram Project 2] Mew Item.. Ctrl+ Shift+ A
# Cut Ctrl+X (] Existing Item... Shift+Alt+ A
53 Copy Ctrl+C 4 Mew Folder
4 Paste Ctrl+V Add ASP.MET Folder 3
Delete Del 4% Class... Shift+ Alt+C
Rename

=N

31 Open Folder in Windows Explorer
Properties Alt+Enter

L Optional } /A4 Parameter defaults ‘—’I

[ B :& =u Y°E]
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http://localhost/

namespace Hel lowor|dipp3.Controllers

{
public class HomeControl ler ¢ Controller
V4
/¢ GET: /Home/
public ActionResult Index( )
{
return View( )
}
}
}

i :YEy & =suF  H]

—F "+ Y'Ey & =1/ = eq71 IndexActon £ 1" L Q@

+T Q0O os IEIndex/ Qos " L K€ el View/ O4 95 Model L "~ A d+n
: HO.

3. View

Controller € Y'EH" n, ,+ & = Controller  ~ ' >L O+ n Viewl Y'EHn Q o.+
View® G T YEf" & o.

12



public ActionResult Inr
{ E]  Add View... Ctrl+M, Ctrl+V
return ¥iewt ) = GoTo View Ctrl+M, Ctrl+G
} Refactor 4
Organize Usings 4
[(;E] Create Unit Tests..,
Generate Sequence Diagram...
=, Insert Snippet... Ctrl+K, X
2, Surround With... Cirl+K, S
@ Go To Definition F12
Find All References Ctrl+K, R
[ View Call Hierarchy Ctrl+K, Ctrl+T
Breakpoint 4
*E RunTo Cursor Ctrl+F10
#  Cut Ctrl+X
B3 Copy Ctrl+C
@, Paste Ctrl+V
Outlining 4
—F & Action/ A g™ w L Ha Addviewa l€d & (k" Ofk1 Ll Qo
+1 . A eol’ G View nu Y'E o Bo.Ft locahostn i 3 aU0aqT
3+ Aol oaw
4. HelloWorld
Nv=+0.he IndexActon/ o4’ ~ EJin

++ Controller / A Viewn wea T L E7]
vloywo.

publ ic ActionResult Index()

{
YiewBag.HelloWorld = "HelloWor|d”;

return Yiew( )

£+ / Homellndex.cshtml / Indexa €™ = by od ¢ §in

<h2>@ViewBag.HelloWorld</h2>

13



+t 7 >L O3 Index Action / A s  ViewBag.HelloWorld + >+ 20e 17 es i Bl
oAl o fo.

HelloWorld

Summary

+K »/ AEMVC b o . ped wn 0 O 0.6 At A1/ AOQ. /K. E
9-%71 " HYR Q n, ., 7 Fn" _  EHER/ £ EY" o.
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[ASP.NET MVC3 >" ]4. Layout, Partial Page

« /AKRNT/ & o — wedky"nS", &/ b AQOWU 0.

1. Layout(MasterPage)

4+ & ASP.NET 2.0/ Master Page A I€ . &4+ 1" " H" o.+  xE XGHIKE html Fnq
X F F + ' L— T OoHlE STL" ad master Pagea I€ *t 1 aspx =FnT
T= ,“'"'& N +n" X a +ﬂ'|'|'°”u'n-|- A Qo ., =qT +*.¥‘+

£y ASPNEY Al v EOinn L n® o B ;" ASPNEV A =aq717 , el
— Tt 43 e HI sF H" o.F1 s, ®ExG +nNn MVC/ A O«
© oy PO 1 0., n/A MVC € & ASP.NETOOoT X N -
HI 31 x & NL wo.MVC/ A"  ViewBag L x & +n¥ " 1 K1+
" tAx T7ELE o

x 717TQ, e/

Add New Item - HelloworldApp3 l = (R
'
Installed Templates Sort by: | Search Installed Templates P ‘

4 Visual C# - .
[ — Type: Visual CZ
Coita cg MVC 3 Controller Class Visual C# o
D — MVC 3 Layout Page with Razor syntax
. o (CSHTML)
General @ | MVC3 Layout Page (Razor) Visual C#
4 Web
MVC3 MVC 3 Partial Page (Razor) Visual C# 3
Windows Forms T
WPF MVC 3 View Page (Razor) Visual C#
Reporting
Silverlight : : :
MVC 3 View Page with Layout (Razor) Visual C#
Workflow
Online Templates MVC 3 View Content Page (ASPX) Visual C#
MVC 3 View Master Page (ASPX) Visual C&
MVC 3 View Page (ASPX) Visual CZ
E | MVC 3 View User Control (ASPX) Visual C&
Web Form Visual C#
=-=| Web Form using Master Page Visual C#
é]Ei Web User Control Visual C#
ch| Class Visual G2~
Name: _LayoutPagel.cshtml

[ B :Xx & +n opf+@/ Fn]
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)0 xa +niE View X ®no Shared %/ 1" ~ yo.F / x4
1" 0.

)+ x8d Fnn od’ “F+oas o.

<IDOCTYPE html>
<html>
<head>
itle> @ViewBaag. Title {/title>
{/head>
<body>
<div>Header — O}AE H 0| X] H AE </div>
<div>
@RenderBody()
</fdiv>
<div> Header — OFAE{H|0|X] HIAE </div>
</body>
</html>

+° / A @RenderBody()ST+ AtT & AT A HssF0o.V Fnn YE x4
+nn Y'E T Hz e ST/ £ & A" VYN~ yo.

3)3K" ° / A =m'E K Home/lndex.cshtml #nn od’ ~+ os o.

@4
Layout = "~/Views/Shared/_LayoutMaster.cshtml”;
ViewBag.Title = "Index”;

¥

<h2> @ViewBag.HelloWorld</h2>

$n

16



HFE H T F 0.

I D Index H Q

€ )'3’ ' L] http://localhost:8900/

B REWE 2 || Firefox BB ) H4l A B i

HelloWorld

Footer - OtAEHIO| Rl HIAE

t kg +n & N 9-Fo0.
2. Partial
68 & =k $+4 nA ASPNET/ A UserControl® -~k &Ll o.41Ek Vview +n%*

Master +n/ ~F OoH ©

.ViewBag L ~ + n, $0 1 Model E~ + n Y o.

ne ¢ avie ' ¢ Yyv a3k Model L i+ o +n/ A @&
& olaxe =VE-NwE
1) Shared %/ Add->Newltem 7 & $nn v . YE o.‘' ‘' g F° E Header’

FooterT A O
2 b/ odr T EbRD Ui 0.

{div>Header - T&H 0| X| B AE <{/div>
[Header.cshtml]

<div> Footer - THaFH| 0| X|E| 2 E </div>
[Footer.cshtml]

17



3) LayoutMaster.cshtml - 0 it n od’ ~+ ws 0.
<IDOCTYPE html>

<html>
<head>
<title> @ViewBaag. Title </title>
</head>
<body>
@Html.Partial("Header")
{div>
@RenderBody()
</fdiv>
@Html. Partial("Footer”)
</body>
<Shtml>

fe i AR 4 o

l D Index
L &) | [ http/flocalhost:8900/
B RE R & | Firefox AIIEHI] 5 ZA RA BI| N
T oo T =i SN - TT— L/ m‘_

|Header - WH&FH 0| R] ElAE
elloWorld

Footer - WH&FH| 0| Rl HIAE

1

>+ @ F W o

Summary

66 = x& Fne-' 60 E- g FA/A T, Vg oomyn £, * o
®Y "o . p. &N/ t+e FKEMVCO ®e ASPNET T, nDy . p+ HIE %i 1°Q,
(;)Q'"T 'AO — . [3]'17A=|=0

18



[ASP.NET MVC3 >~ ]5.Model 7 View> A

++ f £ Model L Viewr Onu ., o.Model k Controller n AT H M aqT
"Ey Model #F View n A O+n~ HiEw, 4+ A Controller * Model L View T O021€
HT E2"n" F- o.M "n HI Lod’ -~ o

- ViewBag_ \' 1 o

- StrongViewn = .
cectlem "nHI L eSS+ 4 wE 0 O2kHT L4 - o.F " 7 HT EAT ¢
» D L"n” Bre,$0 av Fo —x 17 T MVCor . wBLl1+o.
M"RHl +» G Eod' "o,

ZE J=g3

YiewBag{WiewData) GIOIEAH CHEE S2HE 21 #4300 Model & A SE 2I0H YiewBag DI E 2
ViewData 2] 2 2 objectHEE A -EEIEI}'I MEH HeE BadiE =L, O
4.0 M =M= Dynamic Typefl ViewBag = 18 HED| RS0l AED HsSotlh 1
2Lt Dynamic Type2 Runtime AJH S T Z2] | H=TE = &N HEAN SHE
[=]8
Lt

DEXAS CoSE DIUD| M AJ} ST

Tu

=
E0

.

rIF-IHIF

C
StrangYiew Controller Ml A Model & H&de ERED SHR0ICH, Model BHIH O 2500 Z21H
D, RE IE —’F—EJ‘FDDH‘I [H2H A2 M AHME AEQl 2FSTH0E CFFE Model
B %JPE CFEID| ETHEHCL

13 2@l viewtr 02Ewm "n HT L aS a0 Onuu . o.®MChphre 71 Model L
m=E 0.

1) Models %/ ClassLibrary ®L 4+ - o L HelloModel T wa'E ©
2)on%E -k 7 n YE o

namespace Helloworldipp3.Models

{
public class Hel loMode |
{
public String TodayDate { get; set; }
public String HelloMsg { get; set; }
}
}

19
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+t :: o @l viewBag¥ StrongViewn + . A7  Omgu - .

1. ViewBag

ViewBag k MasterPage
Loih cedEL O R

ViewBag 1+ " » -k
¥ PartialPage/ A"~ +
“ kel kE A-yqT ot

13 $+t ViewBag Ll £ . A Model L viewr 7~ Omgu , o.
1) h ¢ HomeController 1+ Index Acton L o4’ ~+ o5 o.

public ActionResult Index()

{
YiewBag.CurrentHodel = new Hel lowor IdApp3.Hodels. Hel loMode | {
TodayDate = Dateline.Now.ToString( ),
HelloMsg = "CHAGIM| R7? YiewBag S STt Model & YULICE. "
|
return View( )
}
2) Index.cshtml £ 04’ ~f+ ®@syo.F =q4&" RLYN QqbT,V=/ T TU
= . 3+ 0 i K€ ViewBag.CurrentModel » @ = - .. °/ % Model L
it A =E 1+o.+lk€i ® |/ ¢=1 ‘A4 K€Ly ' | A il
CQO AT7 1 Wedygpuu o GFKebr ' | A A gEn A

eotvie, Lec o o)

@f
Layout = "~/Views/Shared/ _LayoutMaster.cshtml”;
ViewBag.Title = "Index";

}
<h2>@¥iewBag. CurrentHodel .Hel | oMsg</h2>
@YiewBag.CurrentMode | . TodayDate

20



yf "0 AL oo,

——

| [l Indec\ gV N
‘ w l || http://localhost:8900/ RB g
R 2 & | Firefox NG ‘

OtAolAMl 27 ViewBag QI L|LC}.

YiewBag.CurrentHodel .Hel loHsg

N11-05- o= F2T7 YiewBag.CurrentHodel . TodayDate

Footer - WrZH 0| Al HIAE

[ B 31

—F FeaoFyg1lblpPoBLl1+o.—y $n "' F ~ £ ViewBag.CurrentModel £ View
+n/ as0aq7m v+ 0 E_qe,, 7' " <«AOH .+t 04 g1 StrongView /
L a Omuv .

2. StrongView

- "y Model L' v/ &1 A . — ~ OH" 0.CI Viewn . A Model
€ 1 E ViewBag' N+" 't Ogfo. StrongView 1 " » yy b7 W)y

, j " Fe [—g & wlnL okifo.” _ HA" {¢

View / Data n 9 ol BX T . 17 Q ASP.NET " » vy E" K [ Fno

Af.. MA e oalY / - 0O

21



1) h e StrongView 1 _— Stronglndex A € Action L [ 6 0., ONn¥F - =|=
Q.

public ActionResult Stronglndex()

{
return View(
new Hel lowor|dApp3. Models . He | loModel {
TodayDate = DateTime.Now. ToString( ),
HelloMsg = "9HASHHIR7 StrongView & STt Mode| T&LICEH "
|35
}

2 bk Vv/ §Ey Model L E-YIET 37 b x I >

Ufo.

2)+£ 3»/ A K 1MA AddViewn £ A UT = VD 1" 0.FK/ IE StrongView
" wmE 1F, WY/ ,Ong, B T FView AOo. c@lns o,

v l el

WYiew name:

Stronglndex
View engine:

|Razor (CSHTML) -

Create a strongly-typed view

Model class:

||_||||..IL_"' w | E = e L gy g

Create as a partial view
Use a layout or master page:

~Views/Shared/_Layouthaster.cshtml D
(Leave empty if it is set in a Razor _viewstart file)

ContentPlaceHolder ID:

MainContent |

Add ‘ [ — ]

[ B :Model 7 " ]
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3) #+ Strongindex V1 wwE O= . View)/ e3%’' > E Model _ \/

- Aa"ly Model/ = 7 »° ®

0.

@model HelloworldApp3.Models.HelloModel

@f
ViewBag.Title = "Stronglndex”;

Layout = “~/Yiews/Shared/_LayoutMaster,cshtml”;

}
<h2>@Model .He | loMsg</h2>
@Model . TodayDate

H+e h T O-

sEGB R, T DT b

3. Bonus! StrongPartial

nA ASPNETL t+H s oK @ B  e= .t WebUserControl L o9  —
©, nonv ¥i - T, WebUserControl  behind it/ w4 77 L — Jiin wmE

o.MVC/ Al€E+1+ T" & n:, bn View' EEw$ n Patialt O9IE1T E" & 0.
++ Strong Partial Page " ==E OTUL , O.

1)h e Footer +nn ®n¥ " F ws 0.

@Gmode | Helloworldapp3.Models.Hel loMode |
<div>Footer - M&HO|X| B AE</div>
@Mode | .TodayDate

0in/ AlEM n/ Oo model L sy s 0. K/ 40 g model L sy o
"IESTE - O - STF+0."EK” n/ AlEM Fn/ Asgp ce@l"hzFA
O~ Ko AL O+ 0. fIEView Fn/ A Q- KO’ §& e® HAZo.

2) Strongindex 1 Partial L A © M K e 1 Model L Evno.

&\ Dinkeod o)
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@model Hel lowor|dipp3. Models .Hel loModel

of
ViewBag.Title = "Stronglndex”;
Layout = "~/Views/Shared/_LayoutMaster.cshtml”;

<h2=@Model .He | loMsg</h2=
@Model . TodayDate
@Htm|.Partial("Footer”,Model )

@Html.Partial)E M " n ko 0 Eqgu KT B Yt Lo e

O~ partialpage 7 FnN F° ,mM K* = IEE. EL Model 0.

‘ m I [ [J http://localhostS%O/Horr:éjéfronglnda

|2 RbZ 92 = | | Firefox AZERL 5 HgE: =)

OHA oAl R? StrongView £ Sttt Model M &¢JLICH
odel .Hel loHsg

@Hodel .TodayDate

[ B: & Fn/ wfg 0 alaqTm ¢ ° A

Summary

ViewBag L 4 . HT ' StongView ° M MVC/ A v+ 1 Viewt 47 K€" » ' D 3 Ay
N% HI F0.04 »/ AlEw$ | F& 7 Z&a b6/ b AQadOTWUL | 0.
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[ASP.NETMVC3>" ]16.MVC { d& wd W& [ Y(WithEF)

tKEN, N, pad MVC o w b 0 O o.FK A’/ K QfE HE | FEF
st +HL, e 0 BL140.

7elag Ogyu ,o.FTQMVCT =X (S /  » f

Entity Framework
ORM® @X *T17Q,, Fq ADO.NETOO = X

f p V. IE Microsoft / A | e
_weF _NaqT 2 — AT OH" 0.FT p Jv., € MS/ A ey
O+, v/ ,MVCFmy 'k "EL 041 0.
+K »/ AIKEEFF MVC 7 e LoHu" o,
LING | .
to
S IEnuErirable
Object Services
Entity ] -
Conceptual soL - -
Madel Query L _ _C‘-""'T‘:_'::M ~ EntityDataReader
Mapping - EntityClient Data Provider

Command ‘ DBDataReader

Data Source
[ B :Entity Framework ., p & 4 _ w]
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http://www.sqler.com/391739

<MVvC 4~ B>

pY & Bi$Fn . ®E Ruby on Rails / A V4

CRUD(Create Read Update Deletep K/ O it &

17y Leof, W o.MVChy v s F' 4

0. EFF 1 7 eq7T + FIEX

<MVC¥ EF1 7 e & B >
1.he, F T+ g Model/ A Data L ¢

€ °o .

o K

€0, K , ®F0.FK Model L
®IY% 11 47T QRubyonRails" " » 3,
6L ASP.NETMVCa e/ s A n-

- 5 X/ ADO.NET Entity Data Model L
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